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CHAPTER 1

Overview

CM K2 Inline is a Joomla! component helping you customize K2 component’s back-end item list and edit extra field
inline.

1.1 Features

» Show/hide columns in K2 item list.
* Change ordering of the columns.
¢ Add columns for extra fields to the list.
* Add/edit value of extra fields in-place.
* Add/edit value of an extra field for many K2 items at once.
* Use AJAX to save extra fields.
* Popup notification for the result of AJAX request.
* Tool to create/delete override layout file right in Joomla! back-end.
 Support the following extra field’s types:
— Text field

Textarea (Editor is not supported)

Drop-down selection

Multi-select list

Radio buttons (Displayed as drop-down selection to save space)

Date

— Link

* Integrate with Additional Categories for K2 plugin

1.2 Technical Requirements

e Joomla! 3.x.x: CM K2 Inline is NOT compatible with Joomla! 1.x.x or 2.x.x, only Joomla! 3.x.x is supported.
Please check Joomla! 3’s Technical Requirements for more information.



http://www.netpin.gr/extensions/item/1-k2-additonal-categories
http://www.joomla.org/technical-requirements.html
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* Bootstrap 2: CM K2 Inline is NOT compatible with Bootstrap 3. Bootstrap 2 is available by default in Joomla!
3.x.x. The default template of Joomla! back-end (Isis) uses Bootstrap 2, so this template is recommended, if
you use a custom back-end template, it must support Bootstrap 2.

e K2: CM K2 Inline was tested on K2 2.6.5, 2.6.6, 2.6.7, 2.6.8 and 2.6.9.
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CHAPTER 2

Installation

Installation is easy, just like installing any other Joomla! extension. You just need to use the available tools in
Extension Manager to install (Top menu -> Extensions -> Extension Manager).

Using “Upload & Install” tool to upload the ZIP package of CM K2 Inline to install is the easiest and fastest way.
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CHAPTER 3

Manage Columns

After installing CM K2 Inline, you can find it in Components menu item in Joomla! back-end top menu.

Bl System~ Users ~ Menus ~ Conteni~ Components ~ Exiensions ~ Help ~ Joomla341 & o~

Control Panel Banners “ Joormlal

CM K2 Inline
Contacts
You hz s
Ji lal Updat
» . There a oomlal Update {ages that require your attention. To view those messages please click on the Review Messages button
& Add New Article e K2
D Article Manager Youcay Messaging + by clicking on the Components, Post-installation messages menu item of your site's Administrator section
[ Category Manager This inff News Feeds ou have hidden all messages.
Revi Post-installation Messages

Media Manager i _

Redirect

Search
- qL Smart Search
= Menu Manager '

Tags
W% Module Manager nKz

Access CM K2 Inline, you see the page to manage columns in K2 item list. The core columns which are displayed in
K2 item list are created by default. You can’t delete these columns but you can hide them if you don’t need them in
the item list.
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Bl System~ Users ~ Menus ~ Conteni~ Components ~ Exiensions ~ Help ~ Joomla341 o g~
: ‘el i
[ CM K2 Inline: Columns Joomial
[ Edit + Publish © Unpublish v Show on phone © Hide on phone Check-in X Delete 1 Options
® Q Search fools + Clear 1D descending *|l2o0 -
Template override
% - [J Name Language constant Extra field Status Hidden on phone D
About H ] Ordering v v 1
O Tile K2 TITLE v [x] 2
Title
() Featured K2_FEATURED v v 3
Featured
) Published K2_PUBLISHED v v 4
Published
[ Category K2_CATEGORY v v 5
Category
[ Author K2_AUTHOR v v 6
Author
() Last modified by K2_LAST_MODIFIED_BY v o T

Last modified by

O Access level K2 ACCESS_LEVEL v v 8
Access level

[ Created K2_CREATED v v 9
Created

[J Modified K2_MODIFIED v v 10
Modified

[ Hits K2_HITS v v 1
Hits

You can do the following actions:

¢ New: Create new column for extra field.

Edit: Edit a selected column.

Publish: Show selected columns in K2 item list.

* Unpublish: Hide selected columns in K2 item list.

* Show on phone: Show selected columns on mobile (by removing “hidden-phone” CSS class of Bootstrap 2).
* Hide on phone: Hide selected columns on mobile (by adding “hidden-phone” CSS class of Bootstrap 2).

* Check-in: Check-in a checked-out column (column is being edited and not checked-out).

Delete: Delete selected columns.

3.1 Create new column

Click “New” button on the toolbar to create a new column, you see the form as the screenshot below.
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ot Joomla341 & &

[ CM K2 Inline: New Column ' Joomlal

EEEETE |~ 5o |+ savetton | © canc

Name * Carries Created Date
Language constant CUSTOM_LANGUAGE_CARRIES Created By Select a User. “
Hidden on phone QO Yes Meodified Date
(® No
Modified By Select a User.
Width 10%
1D 0
Extra field Carriers »
Status * (® Published

(O Unpublished

¢ Name: The name of new column.

* Language constant: Language constant for the name of this column. This can be useful when there more
than 2 languages in your back-end and you want to different names based on the current language. You can
use Language Manager to add your custom language constant. If this field is empty, the Name field is used as
column name.

Hidden on phone: Show or hide this column on phone (by adding “hidden-phone” CSS class of Bootstrap 2).

e Width: The width of column in item list. Example: if you want column has 300px widh, you enter “300px”’; if
you want it to take 50% of the item table, you enter “50%".

Extra field: The K2’s extra field which column displays info for.

Status: Published column is showed in item list, unpublished column is not.

3.2 Change ordering

To change the columns’s ordering, you sort the column list by ordering, drag and drop the icons in the first column.
This is the same to changing ordering in other Joomla! core extension like Categories, Content (Articles),...

3.2. Change ordering 9
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CHAPTER 4

Template override

To customize K2’s layout, we need to create override layout file in your template. CM K2 Line has a tool for you to
do this without file manager or FTP access.

Access “Template override” item in the left sub-menu of CM K2 Inline, click on “Create override layout file” button
to create a override layout file.

s v Menus Con

2
4

Compo elp Joomla341e @ -

[ CM K2 Inline: Template Override Joomlal
§ Options
. Create override layout file
Template override
Columns . % < ) 5 B "
To customize K2 item list we need to override K2 item list's layout by using Joomla! Layout Override feature. We need to create the file P isis/html
About /com_k2/items/default.php to override K2 item list's layout.
The file inistrator/ P isis/html _k2/items/default.php doesn't exist. You can click the button below to create override layout file for K2 item list.

Create override layout file

After creating the file, you see a new button to delete the file if you need to.

s v Menus + Content~ Components + E sions ~ Help ~ Joomla341 o Q-

. F A .
[ CM K2 Inline: Template Override Joomlal
£ Options
© Message
Successfully copied override layout file to administrator/templates/isis/htmi/com_k2/items/default.php.
Columns
About
Create override layout file
To customize K2 item list we need to override K2 item list's layout by using Joomlal Layout Override feature. We need to create the file P isis/html

lcom_k2/items/default.php to override K2 item list's layout.
The file administrator/templates/isis/himl/com_k2/items/default.php already exists. You can click the bution below to create override layout file but all of your

customizations in administrator/templates/isis/html/com_k2/items/default.php will be lost. Please consider backup the file to restore later if necessary. If you have just
updated CM K2 Inline to a newer version, you should create override layout file again to have the latest changes in the file.

reate override layout file

f you uninstall CM K2 Inline, you will need manually delete the file administrator/templates/isis/himl/com_k2/items/default.php. You can click the button below to
delete the file then uninstall CM K2 Inline.

Uninstall instruction

11
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CHAPTER 5

K2 item list

After creating columns for extra fields and override layout file, you can check K2’s item list to see the result.

tem ~ Users + Menus ~ Content~ Components ~ Extensions ~ Help ~ Joomla341 & o~

ltems “ Joormlal

Toggle featured state || + Publish || € Unpublish | < Move || O Copy | @ Edit

ltems

Categories

@ Trash || & importJoomial content © Parameters

Go Reset Current ¥ - Select featured state - X - Select category - X

- No user - = - Select publishing state - x - Select language - =
Tags

Comments
Users Batch edit
User Groups

Extra Fields O % Tite Published Category  Carries Chip Imported Date Sale Price
Extra Field Groups

[:2] iPad Air 2 v iPad atat ABX chip with 84-bit architecture and M& motion coprocessor 2015-06-12 $499

Media Manager

Information

20 ~

The values of the extra fields are showed in the item list with dashed bottom border. If extra field has empty value, the
word “Empty” is showed instead (you can change it in the language file).

B System -~ Users~ Menus ~ Content~ Components ~ Extensions ~ elp Joomla34i g @ ~
2l P
A ltems Joomlal
Toggle featured state || + Publish || € Unpublish || < Move | v Copy | @ Edit © New B Trash || & ImportJoomial content 0 Parameters
Go | Reset Current v || - Select featured state - v || - Select category - -
Categories
- No user - * || - Select publishing state - ~ || - Select language - M
Tags
Comments
Users Batch edit

User Groups

Extra Flelds [0 # Title Published Category Carries Chip Imported Date Sale Price
Extra Field Groups

Mo Marager (] :E‘Z % EaC b atat - x ABX chip with 64-bit ar - x 2015-06-12 = - x $499 -
ir

Information (o Sprint
( T-Mobile
[ Verizon

2 -

To edit extra field inline, you click on its value, to save your change you click on the arrow button, to cancel you click
on the X button.

5.1 Batch edit

You can add or edit an extra field for many K2 items at once.

13
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Toggle featured state + Publish || € Unpublish || < Move || [h Copy || [& Edit M Trash || & ImportJoomla! content 0 Parameters
Go Reset Current ¥ || - Select featured state - ¥ || - Select category - ».
Categories
- No user - & - Select publishing state - = - Select language - -3
Tags
Comments
Users Batch edit
User Groups
To edit the same extra field for many items, select the items in the list, enter/select value for the extra field and submit.
Extra Fields
Extra Field Groups Carries Chip Imported Date Sale Price
" sECEN K Empty Empty Emply
Information 3
[] Sprint
[ T-Mobile
[ Verizon
o = Title Published Category Carries Chip Imported Date Sale Price
&) gy = feac ARl B4 ar ¥ oo e A ME MO CONooes S0x 2uls 05,10 dasd
[ IPad Alr 2 L iPad ABX chip with 64-bil architecture and M8 motion coprocessor 2015-06-12 $499
20 «~

In the item list, you select the items you want to change extra field’s value. Click “Batch edit” on top of the list to show
the extra fields. Enter or select value for an extra field and click the arrow button to save. You can continue add/edit
value for other extra fields or refresh the page to see the changes.

5.2 Notification

When you save extra field’s value, there is a notification pop-up telling you if the value is saved successfully or there
is any error occur.

By default notification pop-up is showed at the bottom right of the page and disappears in 3 seconds, you can customize
them in the component’s configuration.
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K2 v2.6.9 | Copyright © 2006-2015 JoomlaWorks Ltd.

Saved successfully.

Joomial 3.4.1 — © 2015 Joomlad41

5.2. Notification 15
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CHAPTER 6

Configuration

To configure the component, you click on the Options button on the right of the toolbar when you are in the pages of
CM K2 Inline (Template override, Columns, About).

m ~ it~  Comp 0 CMK2Inlines & ~

= - i ’a i "
CM K2 Inline: Configuration ¥ Joomlal
v Save & Close @ cancel [ 2] Help
Layout Notification ntegrations Permissions
Global

Configuration
9 Settings for layout.

Text's max length 100
Akeeba Backup

Text’s Max Length option in Layout tab gives you ability to set how long the text of Text, Textarea and Link extra field
type is display in item list. If the text is longer than the length you set, it will be truncated, 3 dots are appended to the
end. This prevents long texts from breaking your item list when they are displayed in full.

~ Exiensions ~ Help ~ CMK2Inlines @& ~

. : - s 4 .
CM K2 Inline: Configuration ¥ Joomial
+ Save & Close @ cancel [ ] Help
Layout Notification ntegrations Permissions
Global

Configuration
9 Settings for success and failure notifications when editing inline.

E Notification position Top
Akeeba Backup Top left
Banners Top center
Cache Top right
Check-in © Center

CM K2 Inline Center left

Contacts Center right

Bott
Atticles ottom

Bottom left
Smart Search

Bottom center
Installer

Bottorn right
Joomial Update

K2

Timeout (seconds) 3
Languages

There are 2 options that you can configure for notification: the position of notification pop-up and how many seconds
it appears on the page.

17
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B System~ Users~ Menus ~ Content ~ Components ~ Extensions ~ Help ~ CMK2Inlinez @& ~
T : i £ s 4 "
CM K2 Inline: Configuration ¥ Joomlal
+ Save & Close © Ccancel [ 7] Help
Layout Notification Integrations Permissions
Global

Configuration
gure Integrations with other third-party extensions.

K2 Additional Categories plugin @ Enabled
Akeeba Backup Disabled

Banners

Integrations tab is where the options for the integrations with other Joomla! extensions are placed. At the present
CMK?2Inline only integrate with Additional Categories for K2 plugin.
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CHAPTER 7

Additional Categories for K2 integration

By default K2 only allows us to add an item to 1 category. Additional Categories for K2 plugin helps us to add K2 item
to many categories. You can download and find out more about this plugin at http://www.netpin.gr/extensions/item/1-
k2-additonal-categories.

CMK?2Inline has an integration with Additional Categories for K2 to edit additional categories inline right in K2 item
list.

To enable this integration you need to install Additional Categories for K2 plugin, set “K2 Additional Categories
plugin” option to “Enabled” in CMK2Inline configuration.

CMK2Inlines @& ~

i : : i s o
CM K2 Inline: Configuration ¥ Joomlal
+ Save & Close © cancel © Help

Layout Notification Integrations Permissions

Global

Configuratio
QIR REOR Integrations with other third-party extensions.

K2 Additional Categories plugin @ Enabled
Akeeba Backup Disabled

Banners

Go to CMK2Inline’s Columns, enable “K2 Addition]l Categories plugin” column and move it to where you want to
display it.

B System - nts Help ~ Back-end Demo& @ ~

: ‘o .
[1 €M K2 Inline: Columns ¥ Joomial

[ Edit || + Publish || € Unpublish || + Showonphone | € Hideonphone || [ Checkin | ¥ Delete
® Q Search Tools + Clear 1D descending 7. 2 v

Template override
$ - Name Language constant Extra field Status Hidden on phone D
gl i Ordering v v 1
Title K2_TITLE v [x] 2
Title

K2 Additional Categories plugin Additional categories v v 24

Additional categories

Featured K2 FEATURED =] v 3
Featured

Go to CMK2Inline’s Columns, enable “K2 Addition]l Categories plugin” column and move it to where you want to
display it.

The column for displaying and editing additional categories are displayed now in K2 item list.

19
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Additional  List Sale
Title categories Price Price

@

iPad Air 2

iPad Air

iPad mini 3

cxwa
Imporied Internet  Storage Technical
Carriers  Chip Date Access  Capacity Detalls Detail URL
il HEE Empty
Sprint
Empty,  WER, {8208 Empty
Empty Wi-Fi 128GB Empty
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CHAPTER 8

Update

You can update CM K2 Inline with Joomla!’s Extension Manager, the same way you update other Joomla! extensions.

After you update, you should go to Template override section in CM K2 Inline to click “Create override layout file” to
update the override layout file in your template’s override folder. This makes sure you have the latest code, otherwise
there would be errors.

21
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CHAPTER 9

Uninstallation

You can remove CM K2 Inline with Extension Manager. Before you uninstall, you need to go to Template override
section and click “Delete override layout file” button to delete the override layout file in your template’s override
folder.

If you forget deleting override layout file before you uninstall CM K2 Inline, you still can delete it man-
ually by using file manager in your hosting control panel or FTP client. The file is located at adminis-
trator/templates/ TEMPLATE NAME/html/com_k2/items/default.php, replace TEMPLATE_NAME with the name
of your default back-end template, if you use the default back-end of Joomla! the file path is administra-
tor/templates/isis/html/com_k?2/items/default.php.

If override layout file still exits in your template’s override folder after you uninstall CM K2 Inline, you will have
errors in your K2’s item list.

23
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cHAPTER 10

Translation

If you need to translate CM K2 Inline to other languages, you can find the English language files at:
* administrator/components/com_cmk2inline/language/en-GB/en-GB.com_cmk2inline.ini
¢ administrator/components/com_cmk2inline/language/en-GB/en-GB.com_cmk2inline.sys.ini

If you just want to change some words or sentences, you can use Joomla!’s language override function (Extensions
-> Language Manager -> Overrides) to find and override them, your overrides are not lost when you update CM K2
Inline.

25
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CHAPTER 11

Indices and tables

¢ genindex
* modindex

e search
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